A guide to using EndNote 20
Contents
Introduction ................................................................................................................................................... 2
Top tips to keep in mind when using EndNote ......................................................................................... 2
Part 1: Creating and adding references to an EndNote library ............................................................... 3
1. Opening EndNote and creating an EndNote library ............................................................................... 3
2. Exporting references to your EndNote library ........................................................................................ 3
3. Manually adding references to your EndNote library ............................................................................. 4
4. Attaching full text articles and other documents to your references ...................................................... 4
5. Importing full text PDFs into your EndNote library ................................................................................. 5
6. Working with PDFs in EndNote .............................................................................................................. 6
Part 2: Inserting in-text citations and creating a bibliography with EndNote ....................................... 6
1. Choosing the appropriate referencing style ............................................................................................ 6
2. Inserting in-text citations ......................................................................................................................... 6
3. Creating a bibliography ........................................................................................................................... 7
4. Editing citations ....................................................................................................................................... 7
Part 3: Managing your EndNote library ...................................................................................................... 8
1. Using groups ........................................................................................................................................... 8
2. Checking for duplicates ........................................................................................................................... 9
3. Syncing with EndNote Online ................................................................................................................. 9
Further help ................................................................................................................................................. 10
Appendices .................................................................................................................................................. 11
1. Exporting from Ovid databases ............................................................................................................ 11
2. Exporting from the Library search......................................................................................................... 11
3. Exporting from Google Scholar ............................................................................................................. 12

If you require this information in an alternative format (ie large print, braille or audio format), please contact
any library enquiry desk or telephone (0113) 343 5663 and staff will make the necessary arrangements

Introduction
EndNote helps you collect and store all the references you have found from different sources. You can use
your EndNote library to insert in-text citations and create bibliographies within Microsoft Word documents,
reformatting them into your chosen referencing style.
If this is your first time using EndNote, we recommend you go through this whole guide in order.
This guide assumes that you are using EndNote with Word 2016 and Internet Explorer, though you can use
any other browser.
By the end of this guide you should be able to:


Create an EndNote library



Add references to your library



Use your EndNote library to insert in-text citations and create a bibliography in Microsoft Word 2016



Effectively organise your EndNote library

Top tips to keep in mind when using EndNote
1. Use one EndNote library for your course, whole PhD or projects you are working on, and use the
groups feature in EndNote to organise your references. We would only recommend you create
multiple EndNote libraries if you are working on a number of different research projects (Using
groups: part 3, section 1).
2. Always save a back-up copy of your EndNote library by selecting File > Save a copy.
3. Check for duplicates on a regular basis. Having duplicate references in your EndNote library can
cause a number of problems, especially when you start to reference your work. (Checking for
duplicates: part 3, section 2).
4. Even when using EndNote, it is important to check that the references are appearing properly in your
work by comparing them with the official referencing guidelines for your style:
library.leeds.ac.uk/referencing. If a reference is not appearing correctly in Word, there may be errors
in the actual reference in the EndNote library. You will need to edit the reference details (Creating a
bibliography: part 2, section 3).
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Part 1: Creating and adding references to an EndNote library
1. Opening EndNote and creating an EndNote library
These instructions describe using EndNote 20 on a computer in an IT cluster.
1. Click Start (or the Windows icon at the bottom-left of the screen), and in the search box that appears,
type EndNote. EndNote should appear on the list of Programs. Click on it.
2. Once EndNote is open, click File and then New.
3. Give the file a name and save it to your M:drive (My Documents).
If you want to use EndNote on a personal laptop, you will need to access it through Apps Anywhere
(appsanywhere.leeds.ac.uk). Visit the IT Service Desk website to learn more about using Apps Anywhere:
https://it.leeds.ac.uk/it?id=kb_article&sysparm_article=KB0014827.

2. Exporting references to your EndNote library
EndNote can receive references directly from a range of search tools, including many databases; this is
known as “exporting” references.
Once you have run your search, most databases have a direct export feature that automatically transfers
your search results into your EndNote library. Every database is different, but look for links or buttons within
the database that say “export”, “EndNote”, “send to” or “download citations”. If you are not sure whether the
database allows you to export to EndNote, consult the “how to” information in its help section.
To try this out, you can follow the example below using Web of Science, or select another search tool that
you use regularly. There are additional examples for Ovid databases, the Library Search and Google
Scholar in the appendices of this guide.
Your subject page also provides information on databases in your subject area: library.leeds.ac.uk/subjects
Exporting references from Web of Science:
1. Go to the Library homepage at library.leeds.ac.uk or access Library Search from the My Leeds tab in
Minerva.
2. Type Web of Science into the search box.
3. Web of Science should be at the top of the results list as a “suggested database”. Click on the link
Go to Web of Science.
4. Enter your University username and password if prompted.
5. You are now at the Web of Science homepage.
6. In the search box, type your keywords and click Search.
7. On the results screen, select the records you want by clicking in the box to the left of each reference.
8. Above and below the results, you have the option to “Export”. Select EndNote Desktop.
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9. A pop-up box will appear. From the options, choose how much of the record you want to export; we
recommend you include the abstract. Select Export.
Your records are automatically imported into the EndNote library that you have opened. If you do not have
an EndNote library open, you will be prompted to choose one.
In some browsers, your records will be downloaded in a file displayed at the bottom of your screen. Click the
file and choose Open to import the records to EndNote.
If you are ever prompted for an import filter, scroll down the list that you are presented with and select the
database you are using, eg Web of Science.

3. Manually adding references to your EndNote library
Not all databases and search tools have the facility to transfer automatically your search results into
EndNote. You will need to enter them, and any references you already have, manually.
Guidelines for entering new references:
1. Go to your EndNote library

2. Click References and then New Reference, or select the new reference icon
3. Select the appropriate Reference Type before entering any details. This will mean that the correct
field titles (Author, Journal, Volume, etc.) are available and so ensure that your reference will format
correctly
4. You only need to enter information into fields that are essential parts of the reference for your
reference list or bibliography
5. Authors can be entered in the format Bloggs, Jo C. or Jo C. Bloggs
6. Organisation names must be followed by a comma (eg Department of Health, ) otherwise EndNote
will assume the last word is an author's surname and your citations will appear as (Health, 2005)
instead of (Department of Health, 2005)
7. Where there is more than one author, enter them on separate lines (use the return key on your
keyboard after each author name)
8. Red text indicates a name that has not been entered into this EndNote library before
9. Move between fields with the tab key or by clicking on each field
10. Click Save to add the reference to your library.

4. Attaching full text articles and other documents to your references
1. In your EndNote library, highlight the reference you want to attach the file to
2. On the summary panel, click + Attach file
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3. Find the PDF file that you want to attach and click Open.
You can then select the PDF in the summary panel to open and read it.

You aren't restricted to attaching PDF files; you can also attach Word files, Excel files, etc, and you can
attach more than one file to a reference.
Important: By default, EndNote will make a copy of the file and place it in a folder associated with your
EndNote library. If you just want to link to the original, make sure you un-tick the box marked "Copy this file
to the default file attachment folder and create a relative link".
Please note that:
Un-ticking the box means that EndNote will need to be able to locate the PDF on your computer when you
want to access it, eg if you have saved the PDF in your M: Drive on a campus PC, you will need to be using
a campus PC or Desktop Anywhere to access it.
Leaving the box ticked means a copy of the PDF will be added into your EndNote library (every EndNote
library creates an attached data folder and the PDF is copied into this folder). This uses up computer
memory.

5. Importing full text PDFs into your EndNote library
You can import a PDF file or a folder of PDFs directly to your library. EndNote automatically creates the
reference for you when you import the PDF(s).
1. In your EndNote library, go to File then scroll down to Import, selecting File
2. Select Choose, then find the PDF file you want to import
3. From the Import Option drop-down menu select PDF, then select Import
4. To import a batch of PDFs, go to File then Import, and select Folder instead of File
5. If you have sub-folders containing PDF files, ensure you select include files in subfolders before
clicking Import
6. EndNote will extract the basic bibliographic data from most PDFs, in order to automatically create a
reference for you when you import the file
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7. If you import a PDF and the details of the reference are not imported, you will need to manually edit
the reference yourself.

6. Working with PDFs in EndNote
1. Select a reference in your library
2. On the summary panel, click the name of the PDF and then choose Open
3. In the PDF viewer you can search the whole document, highlight, strikethrough and underline text,
and annotate with sticky notes
4. You can save all your annotations.

Part 2: Inserting in-text citations and creating a bibliography with
EndNote
EndNote has a feature called Cite While You Write, which starts creating your bibliography as soon as you
insert your first citation into a Word document. Word 2016 has an EndNote tab that allows you to work
between your Word document and the references in your EndNote library.

1. Choosing the appropriate referencing style
Before you insert any citations into your document, choose the referencing style that you want to use. If you
later decide you need to reference in a different style, just follow these same instructions to reformat your intext citations and bibliography in another style.
1. In Word, click the EndNote tab at the top of the screen to see

the EndNote options
2. In the Bibliography section at the top of your screen, click the

drop-down menu next to Style:
3. Click on Select Another Style to see all available styles
4. Scroll down to the style you want, eg LeedsUniHarvard
5. Confirm OK and now all citations and references will be formatted in that style.

There are three output styles to match the Library referencing guidance for Harvard, Numeric and MHRA
(you will find them under LeedsUniHarvard, LeedsUniNumeric and MHRA (Footnote) Leeds Univ). If they
don’t appear in your list, you can download them here:
library.leeds.ac.uk/info/1403/endnote/44/using_endnote_off-campus/2

2. Inserting in-text citations
1. Open a new document in Word and enter some text. Leave the cursor flashing where you would like

the citation to appear.
2. Click the EndNote tab at the top of the screen.
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3. Click Go to EndNote to switch to the EndNote library you have open.
4. Select the reference you want (hold Ctrl or Cmd while clicking if you want to select more than one

reference).
5. Go back to your Word document and click the words “Insert Citation” (not the picture button

immediately above it). Then click Insert Selected Citation(s) on the drop-down menu that appears.
6. The citations will appear in your Word document where the cursor was flashing, and a corresponding

references will be added to the bibliography at the end of the document.

3. Creating a bibliography
Word and EndNote automatically format the references you add, inserting a bibliography at the end of your
document.
If new citations added to your text are not automatically appearing in your bibliography, click on the Instant
formatting drop-down menu and select Turn instant formatting on.

If you want to change the way your references are set out, eg adding spaces between each reference,
removing the indent from the second line of each reference, select the Configure bibliography button
underneath the instant formatting options, then select the Layout tab from the pop-up box that appears.
If the references in your bibliography do not look correct, it may be that the information is wrong in your
EndNote library. To fix this:
1. Go into your EndNote library and select the relevant reference
2. On the summary panel, click Edit
3. Manually edit the reference in your EndNote library and then press Save
4. Go back to your Word document, select the EndNote tab and select Update Citations and
Bibliography.

4. Editing citations
In some instances, you may need to include page numbers in your citation (for example if you have used a
direct quote), or you might want to exclude the author (for example if the author's name appears naturally in
the text - "Smith (2005, p.21) asserts...")
Adding page numbers to your citation:
1. Highlight the citation in your text
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2. In the EndNote tab in Word, choose Edit and Manage Citation(s) from the Citations box
3. In the Suffix section, enter the page number, eg p.23. (You may need to precede p. with a space
and a comma so there is a gap and comma between the year and page numbers: , p.23 )
4. If you are using the MHRA (footnote) Leeds Univ style, write the page number in the Pages section
instead. You do not need to add p. or pp.
5. Click OK.
Excluding the author from your citation:
1. Highlight the citation in your text
2. In the EndNote tab in Word, choose Edit and Manage citation(s) from the Citations box
3. Next to the word Formatting, open the drop-down menu and select Exclude author or Display as
Author (Year) (you can also choose to exclude the year or have the citation appear as a reference
in your bibliography only)
4. Click OK.

Part 3: Managing your EndNote library
1. Using groups
EndNote allows you to add references to groups. If you are using one library to work on several projects, or
on several modules, this can be a very useful tool. References can belong to more than one group.
1. In EndNote, click on Groups, then Create Group
2. Under My Groups in the left-hand panel, you will see an entry called New Group. You can overwrite
this with your own group name. You can rename a group by right clicking on the group name and
selecting Rename group from the menu.
3. To add references to your new group, select the references you wish to add by highlighting them
(hold down the Ctrl or Cmd key as you click to select multiple references). Right click on the
reference(s), choose Add references to and select the appropriate group from the list. Alternatively,
click on Groups in the toolbar, then Add references to and select the appropriate group from the
list.
4. You can also drag and drop references into groups by selecting them and dragging them with the
cursor across the screen into a group.
5. To remove references from a group, open the group by clicking on it. Select the references you wish
to remove and go to Groups and then choose Remove References from Group. The references
will be removed from the group but will remain in the All References part of your EndNote library.
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2. Checking for duplicates
If you import references from more than one set of results (eg from two different databases or from two
searches on the same database), you will probably end up with several duplicate references in your library.
Duplicates can cause problems when working with Word, as you can inadvertently end up with duplicate
citations and multiple entries in your bibliography. EndNote can help to remove them.
To identify duplicate items:
1. Click on Library on the top toolbar, then click Find Duplicates.
2. A new window will show you the duplicates that have been found and invite you to select which one
to keep. It shows you the details of two matching items, with any differences highlighted in blue.
3. To select the item to keep, click Keep This Record. The other reference will be moved to the Trash.
If you want to keep both, click Skip.
EndNote looks within the library for references of the same type with matching author, year and title fields. It
is possible that one of the duplicates will contain more detail than another, so you may have a preference as
to which reference to keep.
You can find a greater number of duplicates by trying different combinations of duplicate preferences:
1.
2.
3.
4.

Go to Edit, click Preferences and then Duplicates
Select or unselect fields to change the criteria, then click OK
Click Library and Find Duplicates again to find references that match your new criteria.
For a thorough de-duplication check, we recommend you select each of the following different
combinations before running Find Duplicates again:
a. Year, Author, Pages
b. Year, Journal, Title
c. Author, Journal, Title
d. Year, Title

The Find Duplicates tool might not identify every duplicate record due to differences in the punctuation and
spelling of journal names, article titles, and author information. To catch them all, you should also always
manually check for duplicates.
To manually check for duplicates:
1. Sort the references in your library by clicking on the Author or Title column headings. This
should help you to find any remaining duplicates by reading down the list.
2. Delete a duplicate reference by right-clicking on it and selecting Move References to Trash.
You can also press Ctrl+D on your computer keyboard.

3. Syncing with EndNote Online
If you want to use your EndNote library when you are away from a University computer, you can create an
EndNote Online account to synchronise between different devices or to access your library from a browser.
You might choose to use EndNote Online as the only way of managing your references (on and off
campus), but please note that it has fewer features than the EndNote desktop version introduced in this
guide.
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Our EndNote Online Guide library.leeds.ac.uk/info/1403/endnote/45/endnote_online_guide will help you to
set up an account and to learn how to use EndNote Online.
If you have an EndNote desktop library, it is important to ensure that the references in your desktop library
are synchronised with your online library, so that the same information is available in both. Please note that
you can only sync one EndNote Online library with one desktop library per computer. Syncing will make the
references in both libraries identical.
To ensure that your desktop library syncs with the correct EndNote Online account, you will need to connect
the two by setting your preferences in the desktop version:





Go to Edit, then Preferences
Choose Sync from the left-hand menu, and fill in the EndNote Account Credentials (your EndNote
Online email address and password)
At the bottom of the EndNote Preferences Sync window, you will also find an option to tell EndNote
to sync the libraries automatically, ie each time a reference is added to the desktop version.
You can choose to sync the libraries at any time by going to the Library menu in the EndNote
desktop version, then selecting Sync

Further help
For comprehensive guidance on all aspects of using EndNote, please see our EndNote support pages:
library.leeds.ac.uk/info/1403/endnote/43/endnote_support
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Appendices
1. Exporting from Ovid databases
These instructions are for Medline but the same principles apply to all other Ovid databases, including
PsycINFO and Embase.
1. Go to the Library homepage at library.leeds.ac.uk or to the ‘Learn’ tab in Minerva
2. Type Medline into the search box
3. Medline should be at the top of the results list as a ‘suggested database’. Click on the link Go to
Medline.
4. Enter your University username and password if prompted
5. In the alphabetical list, find and click on the link to the most recent section of the database: Ovid
MEDLINE(R) (ALL)
6. You should now be on Medline’s advanced search screen
7. In the search box, type your word or phrase and click Search
8. Choose which results you want to keep – you can tick individual results or tick the box at the top of
the list to select All
9. Click on the Export option on the bar above your main list of results. This should open a window.
Click on the Format drop-down menu and choose RIS (not EndNote)
10. Under Fields, choose how much of each reference you want to keep. For this exercise, the second
option Citation, Abstract will be sufficient
11. Then click Export to download the references. If you are prompted to Save or Open the downloaded

file, choose Open to add the references to your Endnote library.
If you are using Chrome as your browser, then your records will be downloaded in a file displayed at the
bottom of the screen. Click the file to import the records to EndNote.
Your records are automatically imported into the EndNote library that you have opened. If you do not have
an EndNote library open, you will be prompted to choose one.

2. Exporting from Library Search
1. Go to the Library homepage at library.leeds.ac.uk or to the “Learn” tab in Minerva
2. Carry out your search using the search box
3. From your search results, mark the items you wish to keep by clicking on the pin icon next to each
item. This will add them to your my favourites section, which can be accessed at the top right of the
screen
4. In my favourites, select all the items you wish to export by clicking on the number next to each one.
5. Now click on the ellipses (

…) near the top of the screen

6. From the export options select Export RIS (EndNote) and then Download
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7. If you are presented with a window asking if you want to "Save" the file, choose to save it. From the
following window, choose to “Open” it.
8. If you do not have an EndNote library open, you will be prompted to choose one.

3. Exporting from Google Scholar
Note that you can only export references one at a time, so this option is not suitable for supporting
comprehensive literature searching.
You will need to update your preferences inside Google Scholar before you can send any references to
EndNote. Follow these steps to configure Google Scholar to send references to EndNote.
1. Go to the Google Scholar homepage at scholar.google.co.uk

2. Click on the 3 horizontal lines at the top left of the screen
3. Click on the "Settings" link
4. Under "Bibliography Manager", select the option "Show links to import citations into" and choose
"EndNote" from the menu
5. Click on the "Save" button
Follow these steps to import search results into EndNote.
1. After performing a search on Google Scholar, click on the "Import into EndNote" link under the
reference you want to import.
2. If you are presented with a window asking if you want to "Open" or "Save" the file, choose to open
the file.
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